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The VB development
environment

This chapter explains:

l how to create a VB project;
l how to manipulate controls and their properties at design-time;
l how to run a program;
l how to handle a button-click event;
l how to display a message box;
l how to place text on a label at run-time;
l how to locate compilation errors.

l Introduction

Throughout this book, we use ‘IDE’ to stand for the VB Integrated Development
Environment. In the same way that a word-processor is a program which provides facil-
ities to create documents, an IDE provides facilities to create (develop) programs. All
the facilities that we require have been integrated and we can work totally within the
IDE, rather than having to use other programs. It provides a complete programming
environment.

l Installation and configuration

Visual Basic 2010 Express can be downloaded for free from Microsoft’s website. The
link changes, but you will initially see a link to Visual Studio Express. Register when
instructed to do so.

We now explain how to group your future VB programs in a convenient folder.
When you make a program, VB creates a number of files and places them in a new
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8 l Chapter 2/The VB development environment

folder. Such a collection of files is termed a ‘project’. It is sensible to create a top-level
folder to hold all your projects. The default folder that VB uses is called Projects in My
Documents\Visual Studio 2010 folder on the C drive. This will be fine for most
users, but if you need to alter the folder, do the following:

1. Click on the Tools menu at the top of the screen. Select Options . . .
2. Click Projects and Solutions and click on . . . to the right of Visual Studio

Projects location
3. A Project Location window opens, allowing you to choose a folder or to create a

new one. Click OK when finished.

From now on, VB will store all of your work in the default projects folder, or in your
specially-selected one. However, the very first time you save a project, a Browse but-
ton (see figure 2.9) is provided, should you need to deviate from your selected folder.

Now we will set the Strict option.

In the same way that a spell checker is useful in word-processing, so the VB facilities for
detecting typos and incorrect use of data are useful. They can prevent hours spent try-
ing to find a mistake in the program. To configure VB for maximum checking, do the
following:

1. Click on the Tools menu at the top of the screen. Select Options . . .
2. An options window opens. Open up Projects and Solutions by clicking the arrow

alongside it. Select VB Defaults.
3. Set Option Strict to On, and ensure that Option Explicit is left at its On setting.
4. Click OK to confirm the settings.

VB will now perform its highest level of checking on your code.

l Creating a first program

The program we create will display the message Hello World on the screen, but what-
ever the program, the steps are the same.

l Run the IDE. The Start Page appears, as in Figure 2.1
l Click the New Project . . . link. Figure 2.2 shows the New Project window which

appears.
l Ensure that Windows Forms Application is selected. Choose a project name.

This will become a folder name. Stick to letters, digits and spaces. Here, we chose
First Hello. Click OK. A design area opens up, similar (but not identical) to
Figure 2.4.

l In your early days with VB, it will be useful to make the toolbox permanently visible.
Choose View | Other Windows | Toolbox, then click on the ‘pin’ symbol as
shown in Figure 2.3. The toolbox is now pinned permanently open, and your
screen should now closely match Figure 2.4.
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Figure 2.2 The New Project window.

Figure 2.1 The Start Page.
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10 l Chapter 2/The VB development environment

The above steps are typical for any project. Let us now do a specific task for this 
particular project.

Note the form and the toolbox in Figure 2.4. We are going to select a control from
the toolbox and place it on the form. Here are the steps:

l Locate the toolbox. Click on Label.
l Move the mouse to the form. Hold down the left button, and drag the mouse to

create a label as in Figure 2.5.
l We will now set some properties of the label: right-click on the label and select

Properties. Move to the Properties list at the bottom right of the screen, as shown
in Figure 2.6.

l Scroll down to the Text property, and replace the existing Label1 with Hello World.
l Now, we run the program by clicking the arrow at the top of the IDE (Figure 2.7)

A new window appears, as in Figure 2.8. This is the program that you have created. It
merely displays some text, but it is a proper window in the sense that you can move it,
resize it and shut it down by clicking the X at the top right corner. Experiment with the
window, then close it.

To save your program for future use:

l Go to the File menu, selecting the Save All option. (We use a shorthand for such
actions, writing it as File | Save All.)

l The Save Project window appears, as in Figure 2.9. Ensure that Create directory
for solution is checked. Leave its other settings unaltered, and click Save. When
you do a save again, the same settings will be used automatically, and the Save
Project window will not appear.

You can now use File | Exit to leave the IDE.
When you return to VB later, your project name will appear on the start page, and

can be opened with a single click. The work we did on setting up the project does not
need to be repeated.

Figure 2.3 After pinning open the toolbox.
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Figure 2.5 Form with label added.

 

Figure 2.4 The IDE at design-time.
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Figure 2.8 Screenshot of running the First Hello program.

Figure 2.6 Properties of the label. Figure 2.7 Click arrow to run the program.
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l Controls at design-time

In our First Hello program, we placed a label on a form and altered the text that it dis-
played. The main point of the exercise was to go through the steps involved in creating
a project. Now we will fill in some of the principles of controls and properties.

What is a control? A control is a ‘gadget’ that appears on the screen, to display 
information, to allow user interaction, or both of these. The VB IDE itself uses many
controls. For example, you have made use of the drop-down menus to save projects,
and the OK button to confirm actions. For Windows applications, the toolbox contains
around 70 controls, and part of the programming task involves choosing appropriate
controls, positioning them on a form, and setting their properties. This phase of using
a control is termed design-time to distinguish it from run-time, when the program runs
(executes) and the user interacts with the controls. We create a graphical user interface
(GUI) for the user. Let us examine how controls can be manipulated at design-time.

l A control can be selected from the toolbox, and positioned on a form. The initial
position is not crucial; it is easily changed.

l We can move the control. Hold the mouse within a control. A four-headed arrow
will appear, as in Figure 2.10. The control can now be dragged with the mouse.
Temporary lines appear, to help you align several controls.

l We can resize the control. Clicking on a control shows a number of small boxes
(handles) on the edge of the control. Hold the mouse over one of them. A two-
headed arrow appears, as in Figure 2.11. Drag the edge or corner to resize the
rectangle.

In fact, the approach to resizing depends on the particular control. For example, the
label control has an AutoSize property, which we set to False in Figure 2.11. If we left

Figure 2.9 The Save Project window, with Create directory checked.

Figure 2.10 Moving a control. Figure 2.11 Resizing a control.
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AutoSize set to True, the width of the label is determined by the width of the text it
has to display, and its height is determined by the font size of the text. Some other con-
trols allow the width to be dragged, but not the height. (We set the height via fonts.)
Some controls – such as buttons – allow resizing in all directions. In general, resizing is
intuitive, so explore. However, because labels are so common, don’t forget about their
AutoSize property.

Now we will examine properties. Here is an analogy: a television has properties, such
as the colour of the case, the size of the screen, the current channel it is showing, its
price, and its make.

Each control has a set of properties, which we can adjust at design-time to meet our
requirements. Later, we will see a property being changed at run-time.

Once a control has been placed on a form, we can view its properties by right-
clicking in it, and selecting Properties. A properties window for the selected control
will be shown. The left column contains the property names, and the right column con-
tains the current value. To change a property, we modify the value in the right-hand
column. For some properties, this might involve further selections, as in the settings of
colours and fonts. Sometimes this involves opening up a further window where the
range of values is large.

Another vital aspect of a control is its name. This is not in fact a property, but is
shown in the properties list for convenience, as (Name). The brackets indicate that it is
not really a property.

When you place several labels on a form, the IDE chooses names in this fashion:

Label1 Label2 Label3 ...

These are acceptable for now, but in future chapters we will suggest that you rename
some controls, choosing meaningful names. A control is renamed by modifying the text
to the right of (Name) in the properties list.

SELF-TEST QUESTIONS

2.1 Place two labels on a form. Make the following changes to their properties. After
each change, run the program, note the effect, and stop the program by clicking
on X at the top-right corner.

l Move the labels;
l set the AutoSize property of one of the labels to True;
l alter their Text properties to display your name and age;
l alter their fonts;
l alter their back colour.

2.2 Select the form itself. Perform the following tasks, running the program after
each change.

l Resize the form;
l alter its text property;
l alter its back colour property.
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l Events and the Button control

The program we created earlier was unrepresentative, in the sense that it always dis-
played the same words, and no user interaction was possible. Now we will extend this
program, so that some text is displayed when the user clicks a button. This is an ex-
ample of using an event.

Most events come from the user, and are generated when the user manipulates a
control in some way at run-time. Each control has a number of events it can respond
to, such as a single mouse-click, a double-click, or the mouse being held over the 
control. There are also other types of events that do not originate from a user – for
example the notification that a web page has finished downloading.

In the program that follows, we will detect an event (the click of a button), and 
then cause some text to be displayed in a label. Here is how we create the user 
interface:

l create a new project named Hello Button;
l place a label and a button on the form. The positioning is not crucial;
l set the Text property of the button to Click Me;
l alter the Text property of the label so that it contains nothing.

The program is not yet complete, but run it. Note that you can click the button and it
shifts slightly, to provide confirmation of the click; nothing else happens. Shut down
the form.

Now we will detect the click event. On the design form, double-click on the button.
A new pane of information will open up, as in Figure 2.12. Note the tabs at the top,
showing:

Form1.vb

Form1.vb [Design]

these can be clicked to switch panes. The Form1.vb pane shows a VB program. We call
this program text, or VB code. We are going to modify this code using the editor within
the IDE.

Locate the section:

Private Sub Button1_Click (ByVal sender As ... etc

End Sub

This section of code is termed a method. The name of the method is Button1_Click.
When the user single-clicks on Button1 at run-time, any instructions we place between
the above two lines will be carried out, or ‘executed’. This is because the line ends with
Handles Button1_Click.

In this particular program, we will use an instruction to place Hello World into the
text of Label1. The instruction to do this is:

Label1.Text = “Hello World”
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Type it in exactly as shown, placing it between the Private Sub and the End Sub lines.
Note carefully the last two characters of Label1. One of them is a lower-case L, and 
the other is the digit 1. The exact meaning of lines such as this (which involves an
‘assignment statement’) will be explained in later chapters.

The next step is to run the program. There are two possibilities:

l The program runs correctly. Click the button, and note that Hello World appears
in the label.

l Alternatively, the program might not run, due to an error. In this case, VB displays
a message as shown in Figure 2.13. Check the box, and choose No. The message
will not appear again.

However, the error still needs fixing, so correct any errors in your typing, and run the
program again. Errors are discussed in more detail below.

The new features in this program are:

l It has responded to the click on a button. Placing code so that it is obeyed when
an event occurs is termed ‘handling’ the event.

l It has altered the value of a control’s property at run-time. Previously, we only did
this at design-time. This is a very important part of programming, because we
often display results by placing them in a property of a control.

Figure 2.12 VB code in the editor pane.
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SELF-TEST QUESTION

2.3 Place a second label on the form. Make it show your name when the button is
clicked.

l Opening an existing project

To re-open a project that you created earlier, save and close any current project you are
working on, and move to the Start Page. This displays your most recent projects. To
open one, just click its name. If the project you want is not in the list, click the Open
Project . . . link, and browse to the appropriate folder. Inside the folder, there is a file
of type .sln (solution). Select this, and open the project. To view the form, move to
the Project Explorer at the top right side, and click on the form name to open it.

l Documenting property settings

In this book, we need to provide you with the settings for controls. For a small num-
ber of properties, we can explain these in a few sentences of English, but for a larger
number of properties, we will use a table. In general, we have a number of controls.
Each control has a number of properties, and each property has a value. Note that 
there are a large number of properties for each control, but we only list the properties 
that you need to modify. The other properties keep their default setting. Here is an
example:

Control Property Setting

Label1 Text Hello World
Label1 BackColor Red
Button1 Text Click Me

Figure 2.13 Error action. Check the box, and click No.
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It represents:

l Label1 with its text set to Hello World, and its background colour set to red;
l Button1 with its text set to Click Me.

The spelling of property names should be followed carefully. This will be covered in
more detail in later chapters, but for now, note that they start with a capital and do not
contain spaces.

l Program errors

It is common for mistakes to occur in programs, and the IDE will spot some of them
for you. Here is an example of a mistake:

Label1.Tixt = “Hello World”

When you enter this line, the IDE will underline it. If you hold the mouse over 
the underlined part, an explanation of the error pops up. You should note that the
explanation might be hard to understand (even for experts) or it might be that the error
is in another part of the program. However, your first step is always to inspect the
underlined area for spelling errors. As you learn more of the VB language, your ability
to spot mistakes will improve.

Once the underlined errors are corrected, we run the program. In fact, before the
program runs, a program known as a compiler makes checks on it, and more errors
might be detected. Only when all these compilation errors have been corrected will the
program be allowed to run.

Compilation errors are listed in the Error List window, which opens below the
code. Double-clicking on the error in the output window will take you to the point in
the code where it can be corrected.

Everyone who begins to write programs will encounter lots of compilation errors.
Do not be dismayed. It is part of the learning process.

Once the compilation errors have been fixed, the program will run. Then we might
notice that it runs incorrectly – it has a ‘bug’. Such run-time errors are much harder to
fix, and debugging is needed. We cover this in Chapter 9.

l Editor facilities

The editor does more than just display what you type in. Here are some of its facilities.

l It provides standard clipboard cut, copy and paste, letting you copy code from
other Windows programs.
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l The writing of bigger programs involves more controls and more events. The drop-
down lists at the top of the editor allow you to select a control, and a particular
event for that control. The editor positions itself to the appropriate method.

l As you type in VB code, the editor will lay it out according to certain rules. For
example, spaces will automatically be inserted around the = symbol.

l Some lines will be indented – shifted to the right – by the insertion of extra spaces.
Normally, this is in steps of four spaces. As you will see in later chapters, VB code
consists of sections within sections, and indentation clarifies where a section begins
and ends.

l Some of the letters you type will be converted to capitals, according to the
conventions of the VB language.

l Each type of control has a different set of properties. If you type in a control name
followed by a dot, as in:

Label1.

then wait, the editor will provide a list of the label’s properties.
l Sections of code that we are not working on can be collapsed down to one line 

of code. This is done by clicking the small – at the left of the editor. Click + to
expand a section. You will see these symbols alongside such lines as:

Private Sub Button1_Click(...etc

You don’t have to remember these features – they are there to help you.
One area of layout that is not done for you is the breaking up of long lines. To

ensure that the whole of a line is visible on the screen, you can choose a suitable place
to break the line, and type a space character followed by an underscore _ character,
followed by a new line. Spaces can then be inserted at the left to provide a suitable
indentation. The underscore character is available by using the shift and − combination.
Here is an example, using this line:

Private Sub Button1_Click(ByVal Sender As System.Object ...etc

We can set this out as:

Private Sub Button1_Click( _

ByVal sender As System.Object, _

ByVal e As System.EventArgs) _

Handles Button1.Click

Note the space/underscore combination.
Often, the very long lines are created by the IDE and should not contain errors.

Breaking them is not essential. However, when you progress in VB, some of the 
long lines will be your creation, and it is well worth breaking them so that the whole
text can be seen at once. The readability of printed code (called a listing) is also
improved.
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SELF-TEST QUESTION

2.4 Place a label and a button on a form, then do the following:

(a) double-click on the button at design-time, and insert the line:

Label1.Tixt = “Doug”

Note the underlining, and the error message.

(b) Run the program. Note the error in the Error List, then double-click on it. Fix
the error.

(c) Remove the spaces at the left of the line, and around the =. Click elsewhere
in the code, and note the effect.

(d) Alter Text to text. Note the effect.

l The message box

Earlier, we used the label control to display text on the screen. We can also use a mess-
age box. This does not occur in the toolbox, because it occupies no permanent space
on a form. Instead, it pops up when required. Here is some code which displays Hello
World in a message box, when a button is clicked:

Private Sub Button1_Click( _

ByVal sender As System.Object, _

ByVal e As System.EventArgs) _

Handles Button1.Click

MessageBox.Show(“Hello World”)

End Sub

Figure 2.14 shows what happens when we run the program and click the button.
The message box appears, and we must click the OK button to make it go away. This
feature means that message boxes are used for vital messages that the user cannot
ignore.

To use a message box, key in a line just like the above, putting your own message
inside the double quotes. At this point we will not explain the purpose of the Show, or
why the brackets are needed. This comes later, when we study methods in more detail.

Figure 2.14 A message box.
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SELF-TEST QUESTION

2.5 Write a program which has two buttons on a form. Clicking one button shows 
a message box containing Hello World. Clicking the other button shows a 
message box containing Goodbye Cruel World.

l Help

The help system works from two possible sources: locally from your own computer, or
from the Internet. The Internet one is updated frequently, and is the simplest to enter.
To use this, set up your help system:

1. Choose Help | Manage Help Settings.
2. Click Choose online or local help.
3. On the following screen, choose the online option.

To get help, click Help | View Help. A web browser will run, opening Microsoft’s help
site. You can enter items in the text box provided, and a list of found pages is displayed.

The help results are not always geared to beginners, so alternatively you could try a
popular search engine, entering such phrases as ‘Visual Basic Button example’. Ensure
that you do not study pages concerned with Visual Basic version 6.

Programming principles

l Controls can be positioned on a form at design-time.
l The properties of controls can be set at design-time.
l Programs can change properties at run-time.
l When an event (such as a button-click) happens, the VB system uses the matching

method. We place code within the method to handle the event.

Programming pitfalls

l Forgetting to terminate your running program before trying to modify the form or
code.
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Grammar spot

l In VB code, we refer to the property of a control by using the control’s name,
followed by a dot, followed by the property, as in:

Label1.Text

l A section of code between:

Private Sub ...

End Sub

is termed a method.
l A message box is not placed on a form. Instead, we cause one to be displayed by using:

MessageBox.Show(“Some text you choose”)

New language elements

An introduction to properties, methods, events.

New IDE facilities

l A program is contained in a project.
l The IDE creates a folder to contain the files needed for a project.
l The setting of the project options Strict and Explicit.
l We can move and resize the controls on a form.
l The toolbox contains a range of controls.
l Right-clicking on a control allows us to select its properties.
l Double-clicking on a control at design-time will create event-handling methods.

Summary

Part of the programming task involves placing controls on a form and setting their
initial properties. The VB IDE makes this task straightforward, but you need to
practice with the IDE, as well as reading about it.

EXERCISES

2.1 Create a new project named Demo, and place three buttons on the form. Set their
text to 1, 2, 3 respectively. Create three labels, and set their text to A, B and C. 
Now place suitable code in the appropriate button methods so that:
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(a) clicking Button1 sets the text of all the labels to Yes;
(b) clicking Button2 sets the text of all the buttons to No;
(c) clicking Button3 sets the text values back to A, B, C.

2.2 This involves the use of the Visible property of a control, which can be set to True
or False. For example, the following code makes Label1 invisible:

Label1.Visible = False

Write a program with two buttons and one label. Clicking one button makes the
label invisible, and clicking the other button makes it visible again.

2.3 This program involves the use of the Image property of the label, which makes the
label display an image. Setting this property involves browsing for an image file.
Choose any image you encounter: there are many sample images on most computers,
and their file name often ends in .jpg or .bmp. Write a program with two buttons,
and an image on a label. Clicking one button makes the image disappear. Clicking
the other button makes it reappear.

2.4 Write a program which firstly displays your name in a message box, and then your
age in a message box, when a button is clicked.

2.5 This involves the creation of a simple text editor. Place a text box on the form, and
resize it so that it fills most of the form. Set its Multiline property to True, and its
ScrollBars property to Both. Run the program. Type some text into the text box.
Note that a right-click on the mouse allows cut and paste. Run a word-processor, and
paste text to and from your editor.

2.6 This involves using the MouseHover event, which happens when the user holds the
mouse over a control for a few seconds. To create a method that handles this event,
place a button on the form, and, at the top of the text editor panel, select Button1
and MouseHover. The method to handle the event is created. Write a program which
displays a message box containing Over Button when the mouse is held over the
button.
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ANSWERS TO SELF-TEST QUESTIONS

2.1 This question involves exploration; manipulating properties is a hands-on task.
You will learn how to select controls and manipulate each one individually.

2.2 Note that the Text property affects the words that are shown in the title of the
form.

2.3 At design-time, we clear the Text property of the label (which VB will have
named as Label2). Then we add the following line:

Label2.Text = “Mike”

Place this line immediately below the line which displayed Hello World. Run the
program.

2.4 (a) Hold the mouse over the underlined part to see the pop-up error.
(b) The cursor will be positioned at the incorrect line. Change Tixt to Text.
(c) The IDE puts the spaces back.
(d) The IDE replaces the t with T.

2.5 The following code is added to our message box example:

Private Sub Button2_Click( _

ByVal sender As System.Object, _

ByVal e As System.EventArgs) _

Handles Button2.Click

MessageBox.Show(“Goodbye Cruel World”)

End Sub
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